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OHDOT Sheet Manager 
Description 

The OHDOT Sheet Manager app is a resizable C# Windows Presentation Form MicroStation Addin 

application that is fully integrated with ProjectWise. 

This application is used to update sheet properties (sheet title, sheet number…) for sheets within the 

current WorkSet. 

Software Requirements 

This application was developed using .NET Framework 4.6.2 in 64 bit Windows 10. 

Since it’s a MicroStation Addin, MicroStation CONNECT edition is required to run this (or Open Roads 

Designer CONNECT edition, Open Bridge Designer CONNECT edition…) 

Microsoft Excel 2016 32bit version was use to test the application. Note that this application can still be 

used if Microsoft Excel is not installed but all the features of the application will not be enabled.  

 Loading the Application 

The application is loaded via the OHDOT Sheet Manager option 

from the Ohio DOT Workflow within the Sheets Group. 

It can also be launched with the following keyin commands 

mdl load OHDOTSheetManager; OHDOTSheetManager Open 

Note that the OHDOT workspace must be loaded. 
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Application Operation 

There are two options available for loading this app.  

From Excel 
 This option was added to help reduce loading/processing times. When selected a dialog will 

show where you can select an excel file. the excel file is checked to make sure its the correct format. See 

Excel File Format section for details on correct formatting. All sheets listed in the excel file are added to 

the sheet manager. It does not check the file to ensure the sheet actually exists in the dgn file. The only 

requirement is that the sheet location is within the workset folder. 

From Workset 
 This option will search through the entire workset folder to find dgn files within sheets folders. 

All the dgn files are opened and searched for sheets. all found sheets are then added to the sheet 

manager. This can take a long time depending on the number of dgn files that are found. 

While loading the application will look like the below image. 

 

 

 

 

 

Once loaded the application will look like as shown below. 

See Results/Progress Section for details on which files were omitted. 
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Help Menu: 
The Help Menu consists of two items Wiki and About.  

Wiki-Help Doc/Video(s) 
 Clicking this item will launch a wiki page that consists of a link to this 
help document and a YouTube video (link below) explaining how to use this 
application. 

https://youtu.be/s7lOigsB25k  

About 
 Clicking this item will open another dialog, pictured to the 
right. This dialog displays the following information.  
 

o Application Name  
o Application version 
o Copyright 
o Company 
o Description 

 
 

WorkSet Folder: 
This section of the application gets populated with the directory of the active workset. This is defined 

via the _USTN_WORKSETROOT variable. 

Update Sheets for Agency Cell Button: 

This button was added with version 1.0.0.14. Its 

purpose is to update existing sheets to have the new item type properties needed for placing agency 

cells. It also will set the default values for this new item type properties. Note that when this button is 

selected it will only process the sheets currently displayed. Also note that if a given sheet’s cell has been 

dropped then the default item type properties can not be set and will have to be set manually if you 

want this app to be able to place agency cells correctly. 

Mode: 
 This section of the application contains a drop down box listing the 

different modes available for the app. The modes are listed below. 

 

 

Single File Edit 
 This is the default mode it allows for editing Sheet properties on a per model bases. 

Export to Excel 
 This mode allows for exporting all sheet property data to an excel file for bulk editing. This mode 

adds a button, Export Displayed Data to Excel, as well as hide the properties section of the window.  

https://youtu.be/s7lOigsB25k


 
Ohio Department of Transportation 
Office of CADD and Mapping Services 

January 9th, 
2023 

 

OHDOT Sheet Manager Page 4 

 

Import from Excel 
 This mode allows for import sheet property data from an excel file to update the sheet property 

data within the model. This mode adds a button, Update Displayed Data from Excel Import, as well as 

hide the properties section of the window. 

Filters: 
 

This section of the application allows for filtering the Sheet List section. 

Engineering Folder 
  This filter is a dropdown box that goes populated with all Engineering folders found 

within the active WorkSet that contains at least one valid sheet. 

Discipline Folder 
This filter is a dropdown box that goes populated with all Discipline folders found within 

the active WorkSet (within an Engineering folder) that contains at least one valid sheet. 

Verify All Displayed Sheets Button: 
This button is used to verify the sheets currently displayed in the Sheet List Section. If the From Excel 

option was used then the sheets were not initially verified. This button will go through and verify them. 

If a sheet could not be verified it will be listed in the results section. 

Refresh All Displayed Sheets Button: 
This button is used to refresh the sheet properties with the current values in the dgn file. it will open the 

dgn file in background and if the sheet has not been verified it will first verify it and then get the current 

values and update the sheet manager with these values for all sheets currently displayed. 

Sheet List Section: 
 This section gets populated with all valid sheets found within the active workset. See Valid Sheet 

Requirements for more information on how sheets are validated.  

 Sheet List Columns 
This section displays the following information for each sheet listed. 

  Verify/Refresh 
  This column can have two buttons. 

Verify Button 
This button will verify that the sheet actually exists in the dgn file. this button will 

only be shown if the sheet has not been previously validated. 

Refresh Button 
This button is used to refresh the sheet properties with the current values in the 

dgn file. It will open the dgn file in the background and if the sheet has not been 

verified it will first verify it and then get the current values and update the sheet 

manager with these values for all sheets currently displayed. 

Folder 
  This column displays the engineering folder a given sheet is located within. Use the 

Engineering Folder Filter to filter out sheets based on this column. 
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SubFolder 
  This column displays the discipline folder a given sheet is located within. Use the 

Discipline Folder Filter to filter out sheets based on this column. 

File Name 
  This column displays the file name for a given sheet. 

Sheet Title 
  This column displays the sheet title property for a given sheet. 

Model Name 
  This column displays the model name a given sheet was found in. 

Number 
  This column displays the sheet number for a given sheet. 

Sheet List Actions 
  The following actions are available within the Sheet List Section. 

Double Click sheet row  
  This will open the file and active the model of the sheet row that was double clicked. 

Selecting sheet row 
  This will populate the Properties Section with all the sheet properties available for the 

selected sheet. Note the Properties section is only visible when in Single File Edit Mode. 

Properties Section: 
 This section is only visible when in Single File Edit Mode. This 

section contains a Property List and an Update Values Button. 

 

 

 

 

Property List 
 This list gets populated with all the available sheet properties for the selected sheet in the Sheet 

List Section.  It contains the following columns. 

  Property Name 
   This is the name of a given property. 

  Property Value 
   This is an editable text box that is initially populated with the current value of 

that property. Any changed made here are not applied until the Update Values Button is selected.  

Update Values Button 
  This button will update all the properties for the selected sheet with the values that are in 

the Property Value column. See Results/Progress Section for details on if the update was applied 

successfully. 
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Export Displayed Data to Excel Button: 
 This button is only visible when on Export to Excel Mode. Selecting this button will open a 

new excel file in memory (not saved) and populate it with all the property data for each 

sheet currently listed in the Sheet List Section. Note that the Filters can be used to change what 

is displayed in the Sheet List Section. See Excel File Format for more information on what is displayed 

in the excel file. See Results/Progress Section for details on the export process. 

Update Displayed Data from Excel Import Button: 
 This button is only visible when on Import from Excel Mode. Selecting this button will open a 

File Select dialog. In the file select dialog navigate to and select a saved excel file that contains the sheet 

property data to import. If there are more than one worksheet in the selected file then another dialog 

will open listing the worksheets that were found within the selected excel file. Select the appropriate 

worksheet. After the excel file and/or worksheet has been selected then the data contained in the 

selected worksheet is extracted and applied to the appropriate dgn files. Note that only the sheets 

currently displayed in the Sheet List Section will get updated, even if the selected 

worksheet contains additional sheets that are not currently displayed. Filters can be used to 

change what is displayed in the Sheet List Section. See Results/Progress Section for details on the 

import process and if anything failed to be applied. 

Results/Progress Section: 
This section will show the current progress of a process or the results from the most recent process. 

Warning message lines will have orange text and failed message lines will have red text. 

Load Process 
 This process is started when the application is initially launched. During loading this section 

looks as imaged below. 

 

 After the load process is complete this section will display the results.  

The following lists results if the application was unable to be loaded. 

• Failed to determine if WorkSet is inside or outside of Projectwise  

• Failed to get WorkSet Variables 

• Failed to find Sheet dgns 

• Failed to extract Sheet Data from dgns 

• Failed to load, Unknown error occurred. 
 

 If the application was able to load and there were no discrepancy’s found then the results will 

show the following.  

• Loaded Application! 
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 If the application was able to load but discrepancies were found then the results will show the 

following, with an expander to view the detailed results. 

• Results – Files/models omitted! 
 

 Expanding the results will show every discrepancy found. There are three different types of 

discrepancies, imaged below.  

• Excel not Installed 
    If excel is not installed this discrepancy will be listed. 

• No Sheet found in sheet model 
If a Sheet Type model is found that does not contain a valid Sheet it will 

be listed. 

• Multiple sheets found in sheet model 
If a Sheet Type model is found that contains multiple sheets it will be 

listed. 

Single File Update Process 
  This process is started by clicking the Update Values Button. The results/progress 

section does not change until this process is completed. While the process is running the cursor will be 

the loading cursor. Once the process is the complete the Results will be displayed similar as imaged 

below. 

 

 

 

 Pay close attention to make sure that the process ran successfully. The follow lists the things that could 

fail during the processing and what the result details would show instead. 

• ProjectWise Failures  
a. Failed to get PW working Directory 

b. Failed to check out file 

c. Failed to check file back in (only if it wasn’t already checked out) 

• Failed to open file 
a. Instead of Opened File -> Failed to Open File 

b. Instead of Opened File -> Unknown error, Failed to open file 

• Failed to load model 
a. Instead of Loaded Model -> Failed to load model data 
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• Failed to Update Sheet Properties 
a. Instead of ItemType Values updated in model, saving… -> Unknown error occurred 

when searching for ItemTypes in model 

• Failed to Update Sheet Model Properties 

a. Instead of Updated Model Desc. And Sheet Number Model Properties -> Failed to 

update Model Desc. And Sheet Number Model Properties. 

• Failed to save file 
a. Instead of Saved file -> Failed to save file, ItemType Values NOT UPDATED! 

b. Instead of Saved file -> Failed to updated Item Type values 

 Excel Export Process 
This process is started by clicking the Export Displayed Data to Excel Button. The 

results/progress section does not change until this process is completed. While the process is 

running the cursor will be the loading cursor. Once the process is the complete the Results will 

be displayed similar as imaged below and a new excel file will be displayed with the data, see 

Excel File Format for more information on the excel file that is created. 

 

 Excel Import Process 
  This process is started by clicking the Update Displayed Data from Excel Import Button. 

The results/progress section shows a running progress bar while the process is running. While the 

process is running the cursor will be the loading cursor. The text displayed in the progress bar during 

the process will be similar to what’s imaged below. 

 

 Once the process is the complete the Results will be displayed similar as imaged below.  

Pay close attention to make sure that the process ran successfully. The follow lists the things that could 

fail during the processing and what the result details would show instead. 
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• Failed to select a file 
a. Instead of Selected excel file -> Excel file not selected 

b. Instead of Opened File -> Unknown error, Failed to open file 

• Failed to select a worksheet 

a. Instead of WorkSheet containing data selected -> No worksheet selected in excel file 

• No data in selected worksheet 

a. Instead of Data found in worksheet…validating content -> No data found in 

worksheet 

• Validating worksheet errors 

Each column in the selected worksheet is validated, if a column is not valid the column 

heading will be added to the results as follows.  

a. [COLUMN_HEADING] is not a valid heading, skipped this column’s data 

While invalid columns are allowed if required columns are missing then validation will fail 

and the process will be aborted. See Excel File Format for more details. 

b. Instead of WorkSheet data validated -> WorkSheet data is invalid, process aborted 

After the worksheet data is validated each row in the worksheet is processed, during this process that 

row is checked to make sure that  

a. The row data belongs to a file within the active WorkSet (that file exists) 

b. That file the row data belongs to MUST be currently displayed in the Sheet List Section.  

If a given row does not meet these conditions then that row will not be processed and the results will 

show one of the following 

• Row data in excel sheet doesn’t match any validated file/model in active workset 

• Row data in excel sheet found in active workset but is currently filtered out and was not updated 

If a given row does meet the above listed conditions, then that row is processed the same way as the 

Single File Update Process, see that process for details.  

The results are color coded, red for things that failed and orange for warning messages. 

Placing Agency Cells Process 
 This process takes place during the Single File Update Process and the Excel Import Process. If 

the sheet cell has the new item type properties for placing agency cells which are defined as follows. 

• DesignAgencyCellName 

o Holds the name of the cell to be used as the Agency cell 

• XBaseLength 

o This is the overall base scale width of the border sheet (typically 34) 

• YBaseLength 

o This is the overall base scale height of the border sheet (typically 22) 

• AgencyBoxBaseLowerXDist 

o This is the base scaled distance in the X direction for the bottom left corner of the border 

sheet to the bottom left corner of the box that the agency cell is placed inside of. 

• AgencyBoxBaseLowserYDist 

o This is the base scaled distance in the Y direction for the bottom left corner of the border 

sheet to the bottom left corner of the box that the agency cell is placed inside of. 



 
Ohio Department of Transportation 
Office of CADD and Mapping Services 

January 9th, 
2023 

 

OHDOT Sheet Manager Page 10 

 

• AgencyBoxBaseWidth 
o This is the base scaled width of the box that the agency cell is placed inside of. 

• AgencyBoxBaseHeight 
o This is the base scaled height of the box that the agency cell is placed inside of. 

If the above item type properties exist on a sheet then the Design Agency Cell Name item type property 

should show up in the properties section as well and in the excel file created from the Export to Excel 

Mode. The DesignAgencyCellName property dropdown is populated with all values set on the 

DESIGN_AGENCY_CELLNAMES variable. 

 

 

Resizing Sections 
This application is set up to be able to resize Sheet List Section, Properties Section, and 

Results/Progress Section. There is a vertical black line between the Sheet List Section and Properties 

section that can be clicked and moved left or right to change the width of those sections, as imaged 

below to the left.  It is a similar process to resize the Results/Progress section but the black line is 

horizontal rather than vertical and is only displayed when the Results/Progress Section is expanded, 

this is imaged below to the right. 

 

 

 

Valid Sheet Requirements 

In order for a sheet to be added to the Sheets List Section it must meet the following requirements. 

• Located inside an Engineering folder (400-Engineering, 401-Engineering…) AND inside 
a sheets folder within a discipline folder (/../Roadway/Sheets/, /../Drainage/Sheets/…). 

• Sheet must be in a model of Sheet Type. 

• Only one OHDOT Sheet contained in a model. 
o The sheet itself doesn’t not need to be a cell. More so only one element in the 

model can have an attached ItemType with a ItemType name that starts with 

OHDOT_SHEETS. 
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Note that if no Engineering folders are found then all top level folders (directly inside WorkSet folder) 

are treated like a engineering folder. 

Sheet Properties 

The document/application makes reference to Sheet properties. In terms of this document/application 

a Sheet property is simply a property within an Item Type. Specifically the name of that ItemType must 

start with OHDOT_SHEETS to be considered a OHDOT sheet property. All item types for sheets can be 

found in the OHDOT_ItemTypes library. There are currently 18 different sheet properties, listed below. 

PID 
Sheet Title 
Sub-Title 
Sub-Title 2 
Sheet Number 

Sheet Total 
Subset Number 
Subset Total 
Designer 
Checker 

Reviewer 
Review Date 
SFN1 
SFN2 
Scale2 

Scale3 
Scale4 
CRS

 
Since not every property is shown on every sheet there is a different ItemType for each combination of 

properties. The following lists the different ItemTypes for OHDOT sheets. 

OHDOT_SHEETS_0 
OHDOT_SHEETS_1 
OHDOT_SHEETS_1N 
OHDOT_SHEETS_1NS 
OHDOT_SHEETS_1S 
OHDOT_SHEETS_2 

OHDOT_SHEETS_2N 
OHDOT_SHEETS_2NS 
OHDOT_SHEETS_2S 
OHDOT_SHEETS_3 
OHDOT_SHEETS_3N 
OHDOT_SHEETS_3NS 

OHDOT_SHEETS_3S 
OHDOT_SHEETS_3NS_BRIDGE1 
OHDOT_SHEETS_3NS_BRIDGE2 
OHDOT_SHEETS_3S_BRIDGE1 
OHDOT_SHEETS_3S_BRIDGE2

 
With exception to OHDOT_SHEETS_0, all item types contain the following properties 

PID 
Sheet Title 

Sheet Number 
Sheet Total 

Designer 
Reviewer 

Review Date 
CRS 

 
The number after SHEETS_ represents the number of title lines. Meaning a 2 contains the Sub-Title 

property. A 3 contains a Sub-Title and Sub-Title 2 property. 

The Letter N after the number means there is a north array on the sheet and the following properties 

are contained in those ItemTypes Scale2, Scale3, Scale4. 

The Letter S means there is sub-set numbering on the sheet and the following properties are contained 

in those ItemTypes Subset Number, Subset Total. 

The ItemTypes with Bridge1 in the name have the following additional properties, Checker, SFN1. 

The ItemTypes with Bridge2 in the name have the following additional properties, Checker, SFN1, 

SFN2. 

Excel File Format 

In order of an excel file to be a valid format to be used with this application it must have the following. 

• The first row represents column headings.  

• Must contain the following headings 
 File Name 
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Model Name 

• No data outside the heading columns 

• No empty rows in between data. 

Optional headings (columns) Title Property, Comments Property. If these columns are found then 

the dgn file’s title property and comments property will be updated during an import. 

All other headings should be the same name of a property in the OHDOT_Sheets ItemTypes. Below lists 

all of these headings. If a heading is missing then that property is not updated during an import, if there 

are other headings (nonvalid) then those columns are skipped and play no effect in the import process. 

PID 
Sheet Title 
Sub-Title 
Sub-Title 2 
Sheet Number 

Sheet Total 
Subset Number 
Subset Total 
Designer 
Checker 

Reviewer 
Review Date 
SFN1 
SFN2 
Scale2 

Scale3 
Scale4 
CRS

 
During a export if a property is not displayed for that particular sheet then the cells value is ---NA--- an 
the cell color is set to grey. This is to indicate to the end user that that property does not exist for that 
sheet. 
 
The File Name column must contain the full path of the file. Within projectwise that would represent 
the full path AFTER the Documents folder.  
For example  
pw:\\[DataSourceName]\Documents\01 Active Projects\District 06\Morrow\96213\400-
Engineering\Roadway\Sheets\96213_GY001.dgn 
would be listed as  
01 Active Projects\District 06\Morrow\96213\400-Engineering\Roadway\Sheets\96213_GY001.dgn 
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Manual Edit of Sheet Properties 

Sheet Properties (Item Types) can be edited manually instead of using this application. To do that it is 

important to note that you DO NOT directly edit the text element that is displaying that property. That 

text element is linked to the property and you want to edit the property, which in return will update the 

text element. to edit an item type property you need to know what its assigned it. Item Types can be 

assigned to the file, model, element… In the case of the OHDOT _Sheets ItemTypes they are applied to 

the outside dotted SH_Cut_Line shape. If the sheet cell is not dropped then just select the cell and in 

the Properties expand out the elements and the first element in the cell is the SH_Cut_Line shape, you 

will see the item type listed under that element, selecting it will allow you to modify the value for any of 

the properties in that ItemType. 

If the cell is dropped then simply select the SH_Cut_Line.  

 

 

 

 

 

 

 

 

 

 

 

Updates 

Version 1.0.0.0: Initial Release 

Version 1.0.0.1:  

-Updated code to write the Sheet title to the model description property and the page number to 

the Sheet Number model property. 

-Fix bug that left excel open in the background if an error accrued during an Import from excel 

operation. 

Version 1.0.0.2:  

- Updated code to work around SDK bug that was not updated text fields associated to a Item 
Type Property within a cell. Note this work around is to open the file which dramatically 
increases run time.  
-Added to results the name of the user who has the document checked out. 
-Updated results to show failed messages in red and warning messages in orange. 

Version 1.0.0.3:  

- Made application more dynamic by having it read two new config variables, 
OHDOT_SheetItemTypesInfo, and OHDOT_SheetManagerKeyWord.   
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Version 1.0.0.4: 

- Fixed crashing errors when running from a dgn that’s in projectwise. 
Version 1.0.0.5: 

-Fixed import from excel error that was not formatting date fields correctly. 
-Updated code so that if no engineering folders are found it will search the whole WorkSet 
Directory (Engineering and Discipline filters will not be populated correctly, but can be used 
still). 

Version 1.0.0.6:  

- MUST HAVE MicroStation CONNECT update 13 or OpenRoads Designer 2019 Q3 update to 
use this version of the application. Bug in SDK was fixed allowing text elements that are linked 
to Item Type Properties be updated which making it the active file. This dramatically reduces 
processing time. 

Version 1.o.0.7: Small updates/optimizations 

Version 1.0.0.8:  

-Fixed import from excel problem that was formatting some numbers as dates. 

- Optimized loading dgn files in the background to speed up processing and fix a crashing error. 
Version 1.0.09: 

-Fixed crashing error introduced in v1.0.0.8 (crash only happens when updated the active file 
that’s from ProjectWise 
-Several code updates to make app more stable including being able to close app in the middle of 
a process. (i.e. loading process, or update process. Note that if closed in the middle of updating a 
file it will finish updating that file and then stop) 

Version 1.0.0.10: 

 -Fixed crashing error when updating the active file. 

Version 1.0.0.11: 

- Added ability to tab between property values text boxes. 
Version 1.0.0.12: 

- Updated to handle sheet cells being placed as a shared cell. Placing sheet border cells as shared 
cells is NOT recommended. 
Version 1.0.0.13: 
 -updated to fix bug that was prevented item types from being updated when using import from 
excel. This bug was introduced with the previous version (1.0.0.12) of this app. 
Version 1.0.0.14: 

-Updated to handle placing of agency cells. 
-Added button to update existing sheets with default values for the agency box area (needed in 

order to place agency cells) 

Version 1.0.0.15: 

 -Switched Help menu to launch Wiki page. 

Version 1.0.0.16: 

 - Fixed issue with import/export from excel that was affecting some users. 

Version 1.0.0.17 

 -Added From Excel and From WorkSet options 

 -Added Verify and refresh buttons. 

Contacts 

For any questions, suggestions, or problems with this document please contact the ODOT Office of 

CADD and Mapping Services by use of the following form on the ODOT website: 

https://odot.formstack.com/forms/cadd_servicerequest 

https://odot.formstack.com/forms/cadd_servicerequest
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